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FCC Radio Frequency Interference Statement

This equipment has been tested and found to comply with
the limits for a class B digital device, pursuant to Part 15 of
the FCC rules. These limits are designed to provide
reasonable protection against harmful interference in a
residential installation. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed
and used in accordance with the instruction manual, may
cause harmful interference to radio communication.
However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and
on, the wuser is encouraged to try to correct the
interference by one or more of the following measures:

= Reorient or relocate the receiving antenna.

m  Increase the separation between the equipment and
receiver.

= Connect the equipment into an outlet on a circuit
different from that to which the receiver is connected.

m  Consult the dealer or an experienced radio/TV
technician for help.

CAUTION: Any changes or modifications not expressly
approved by the manufacture of this device could void the
user's authority to operate the equipment.
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Disposal of Waste Equipment by Users in Private Union
|

This symbol on the product or on its packaging indicates that
the product can not be disposed of with your other household
waste. Instead it should be sent to appropriate facilities for
recovery and recycling in an effort to protect human health and
the environment. For more information about where you can
drop off your waste equipment for recycling, please contact
your local city office, your household waste disposal service or
the shop where you purchased the product.

i)

_ﬁ? As an ENERGY STAR® Partner, iVina Inc. has
7 determined that this product meets the ENERGY
STAR guidelines for energy efficiency.

System Requirements

Microsoft Windows XP/Vista/7

1.2 GHz CPU or greater *

512 MB RAM for Windows XP (2+ GB RAM
recommended)

> 1 GB RAM for Windows Vista and 7 (2+ GB RAM
recommended)

500 MB available on the Hard Drive for complete
software installation

> USB 2.0 Port

» CD-Rom drive

> Display supporting full color (32 bit) at 800 x 600

* File conversion speeds and OCR performance are linked to
CPU speed. The faster the processor, the better the results.
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1. Introduction

Congratulations on your purchase of the BulletScan S400
document scanner.

With this scanner, you can quickly scan documents to
increase productivity.

Before you install and operate the new scanner, please take
a few minutes to read through this manual. It provides
proper instructions for you to unpack, install, operate and
maintain the scanner.

The following figure indicates the package contents. Please
check all the items against your checklist. If you do not
receive all the items, please contact your authorized local
dealer immediately.
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Scanner Main Unit

ADF (Auto Document Feeder) Paper Tray
Output Paper Tray

USB Cable

Power Adapter

Power Cord

oOUuhwWwNE=

Note:

1. Only use the BulletScan Type 2 AC adapter (FF-0506:
HEG42-240100-7L or HEG42-240200-7L made by Hitron,
FF-0508/FF0608S: HEG42-240200-7L made by Hitron)
included in the machine. Using other AC adapters may
damage the machine and void the warranty.

2. Please unpack the scanner carefully, and check the contents
against the checklist. If any items are missing or damaged,
please contact your dealer immediately.
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2. Scanner Installation

Precautions

m  Keep the scanner out of direct sunlight. Direct exposure
to the sun or excessive heat may cause damage to the
unit.

= Do not install the scanner in a humid or dusty place.
= Be sure to use a properly grounded AC power source.

= Place the scanner securely on an even, flat surface.
Tilted or uneven surfaces may cause mechanical or
paper-feeding problems.

m  Retain the scanner box and packing materials for
shipping purposes.
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2.1 Installing the ADF Paper Tray Unit

1. Attach the Paper Support to the ADF (Auto Document
Feeder) Paper Tray.

ADF Paper Paper Support
Tray

2-2
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2. Pull out the ADF Release Latch to open the front door to

the left.
/]

ADF
Release
Latch

3. Insert four tabs on the bottom of the ADF Paper Tray
into the slots on the front of the scanner.
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4. Insert two tabs in the middle of the ADF Paper Tray into
the slots on the top of the scanner.

Tabs

Holes
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2.2 Installing the Output Paper Tray

Insert the right and left tabs of the Output Paper Tray into the
holes on the front of the scanner.

Output Paper Tray
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2.3 Connecting the Cables

Make sure the power of scanner is off.

2.3.1 Connecting to Power

Plug the small end of the power adaptor into the power jack of
your scanner. Insert the other end to an appropriate power
outlet.

R

2.3.2 Turning on the Power

After the power cable has been connected, press the power
switch to the “I"” position to turn on the scanner. To turn off
the scanner, please press the power switch to the “"O”
position.

Power Switch
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2.4 Installing the Scanner Driver

1. Place the supplied CD-ROM onto your CD-ROM drive.

2. The software installation screen appears. If not, run
“setup.exe”.

Contents on the installation disc:

o Easy Install: Click to install all bundled software
including scanner driver, BulletScan Manager,
NewSoft Presto! PageManager, and NewSoft Presto!
Bizcard Reader.

. Advanced Install: Choose for a selective
installation.

. Documentation: Click to view quick install guide,
scanner manual, BulletScan Manager manual and
other software manual.

e Go Online: Click to go online to the Bulletscan.com
website.
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2.5 Connecting to Computer

1. Connect the square end of the USB cable to the USB port
of your scanner. Connect the rectangle end to the USB
port of your computer.

e

2. The computer should detect a new USB device and prompt
a "New Hardware Found” message.

3. In Windows XP, installation will continue automatically.

In Windows Vista and 7, click the Finish Installing
Software option, and then click Continue button to
complete the installation.

4. If you are prompted with a Finish dialog, click the Finish
button.

5. If Windows fails to install your scanner, power off your
scanner, shut down your computer, connect your scanner
to a different USB port on the computer, and restart your
computer. Power the scanner back on when your
computer is done rebooting.

Note:
To uninstall the scanner driver in Windows XP leave the
scanner connected to your computer during software removal.
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3. Completing Your First
Scan

3.1 Loading Your Paper

3.1.1 Notice on Using the ADF

Before using the ADF, please make sure that your paper meets
the following specifications:

. Document(s) can range in size from 3.5 by 2 inches to
8.5 by 14 inches (Legal).

. Document(s) can range in weight from 16 to 28 Ibs

o Document(s) should be square or rectangular and in good

condition (not fragile or worn).

. Document(s) should be free of curl, wrinkle, tears, wet
ink, or punch holes.

o Document(s) should be free of staples, paper clips, paper
sticky notes.
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3.1.2 Placing Your Document in the ADF

Fanning Your Document

Standard paper size should feed easily through the scanner.
To avoid occasional paper jam when automatically feeding
multiple documents, flip through the paper before loading.

[N

Document feeding

Place your document with the text face down on the ADF
Paper Tray. Align the two sides of the document with the
slide guides. Please note that the ADF Paper Tray can hold
up to 50-page document at a time.

Your
Document
(Face Down)

Paper Slider
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3.2 Verifying Your Scanner Installation

Once you've loaded your scanner, you should be able to begin
scanning simply by clicking on
the BulletScan icon in the system
tray and clicking on the
destination number.

CH e &) | 1130 AM

BulletScan Manager icon

on Windows XP
w @ N

BulletScan Manager icon
on Windows Vista/7

Customize...

» u— g 1010 AM
By default, selecting number 1 and E A e 10/10/2010
scanning will give you a PDF in

NewSoft Presto! PageManager. For more information on using

the BulletScan Manager, please refer to the BulletScan Manager

User Manual PDF.

If this doesn't work, you can verify if your scanner installation
is correct, iVina provides you a simple image capture program
called iVina Capture Tool. With this tool, you can perform
simple scans to many image formats and immediately view the
results. In addition, you can do use it to do speed tests and
other operations

If your scanner is not responding after installation, the
following procedure shows you how to verify your scanner
installation. If the scanner is not working, please check both
ends of the power and USB cables, verify the shipping lock is
disengaged, and restart the scanner and computer.

Before you begin, be sure the scanner is on.

1. Select Start>Programs>BulletScan>iVina Capture Tool. If
there is nothing in the start menu labeled “BulletScan” you
must install the software from the CD.

2. The Select Scanner Model dialog box will be displayed.
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Select TWAIN (your driver type) and the F200 (scanner
model) and click OK. The following iVina Capture Tool
dialog box will be displayed.

5 Capture Tool (TWAIN) - Fxxx

Fle View Abont -~ Page__ Size
@Se‘“" & o |%|f‘”m‘ ;@ [CWy Scartinage 1| EE
I ' '
' . S File Path
l File Format ave nera
Scan
Setup

Choose your desired file format from the File Format drop
down list box. (Default is BMP, other choice includes TIFF,

GIF, and JPEG.)

Type your desired folder name and file name in the File
Path box. (Default is C:\My Scan\Image.)

Note: If you do not wish to save the scanned image, click
the Save button (Floppy Disk icon) as this option is enabled
by default. Also, if you disable saving, the thumbnail view
will be disabled and you’ll only be able to view the last
captured image.

a) Be
6. Click the Setup button ( ‘zﬁ tulJ) or choose Setup from the
File menu to prompt the Scanner Properties dialog box.
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& Scanner Propertios X
Image | Compression | Color Dropout | Paper || Mulfi-Feed Detection | Preview | Options || Setting | Iprinter | Ir ¢ *
[Front Color I
[JRear Color Binarizstion: | Dynamic Threshald v
[Front Grey Sensitivity TR s
Image — mEm
. ]
S e | ection [ [Front Auto Color Detection
B [CRear Auto Color Detection
Resolution (dpi) 200 [
Tnvert: Black on White v
Sean Souree: | Auto Document Fesder v
[Ctom v

7. From the Image Selection Box, choose your desired image
type for your scanned image. (Default is Front B&W) If
you have a duplex scanner, choose Front and Rear to scan
both sides of your document.

8. Click OK to quit the Scanner Properties dialog box. (To
learn more details about the Scanner Properties dialog box,
please see the subsequent chapter, Using the Scanner
Properties Dialog Box.)

9. Place your document face down on the document glass or
face up in the auto document feeder.

10. In the Scan Validation dialog box, click the Scan button

Hean
( . ) or choose Scan from the File menu.

11. The document will be scanned and displayed in the Scan
Validation screen. After the scanned images have been
displayed, your scanner installation verification is
completed.
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v
‘Thisty-0ne cakes, dampened witn whiskay, bask on wingowsills and
shaives.

Wha are they far?

Friends. Not necessarlly neighbor friends: indecd, the larger share s
intended for persons we've met maybe oace, perheps not st all,
People wheiua struck our fancy. Lika President Roosavelt. Like the
Reverend and Mrs. 1. C. Lucey, Baptist missianarles to Barneo who
st winter. Or the fitte ke grinder who comes
through town twice a year. Or Abner Packer, the driver of the six
'tiock bus froem Mobile, who exchanges waves with us very day a5
h 3 a , a California
<ouple whose car one aftermoon broke down outside the house and
Who Spent a pleasant haur chatting with Us n the parch (yaung Mr.
‘ilston snapped our picture, the only one we've ever had taken). Is 1t
ecause my friend Is sny with everyahe except strangers that these
1

ik yes. Alss, the scrapbooks we keep of thank-you's on White
Housa stationery, time-to-time communications from Calffornia and
Bome, penny post cards,

Naw & ig branch grat windew. The.
kitchen is empty, the cakes are gone; yesterday we carted the list of
them to the post fice, where the cost of stamps turned our purse
inside out, We're broke. That rather depresses me, but My friend
whiskey left in Haha's bottle.
Queenle has 8 §900NTUl In B bowl of Coffea {sne kes her coffee
chicory-navores and strong). The rest we: divide between a pair o
Jelly glasses. We're bath quite awed st the prospect of drinking
traight whiskey; the tBste of It brings Screwesup expressions and
‘sour shudders. But by and by we begin to sing, the twa of us singing
aifierent seags simultaneously. T don't knaw the words ta mine, fust:
struttees* ball But 1
can dance: thar's what L mean o be, a tap dancar In the mavies. My
; the chinaware;
we glggle: 5 If unseen hands were tickling us. Queenie rolls o her

Thumbnail View Fit Page View

12. You can view the scanned image in Fit Page (‘ﬁ‘) or

Actual Size (100%) button ( D ) from the Viewing
toolbars at the right side.

13. Click the Close box or Quit from the File menu to exit the

Scan Validation Tool.
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3.3 A Glance of the Scanner Properties Dialog Box
Scanner Properties [X]
1 — e | Campression | Color Dropout | Paper | Preview | Options | Setting | Information |
[Oomemie Tl 7]
S i El
2 ———— |wIFront B&W X
[Rear B&W Errightness: 04 o — ot 3
Rt e Do | o 0] P a
Resolution (dpd): 200 — 5
Inyert [EBackonWiie = ] 6
7
ScanSovree: [Autn Document Fesder =]
Piofiles [Custom =]
[~ Color Adjustment
1. Tab Options |Choice: Image, Compression, Color Dropout,
Paper, Options, Settings, Information.
2. Image Choose your image type and the side of

Selection Box

document you wish to scan. Options vary
based on type of scanner.

3. Brightness: |Adjust the brightness level from -100 to +100.
4. Contrast Adjust the contrast level from -100 to +100.
5. Resolution Determine the quality of the scanned image.

The industry standard is 200 dpi.

(=)

. Invert

Reverse the color of your scanned image.

. Scan Source

Choice: Auto Document Feeder, Flatbed,
Flatbed (Book), Automatic (This option varies
based on type of scanner.)

. Defaults

Reset all values on the tabs to the factory
default settings.

S400 Manual V.5 Aug 2010
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4. Using the Scanner
Properties Dialog Box

The Scanner Properties dialog box allows you to configure the
scanner’s settings. It consists of several tabbed windows each
of which will be described in this chapter.

& Scanner Properties

Image ]Compreaion Color Dmpout] Paper ] Multi-Feed Detection} Preview] Oph’nm] Setting ] Impxi.mer] i

[ Front Colox s
[Rear Color Binarization: |D}mamlc Thueshold ﬂ
[ Front Gray Sy
e Gray Sensitivity: 20 ﬂ J ﬂ
[IFront Auto Color Detection
[ Rear Auto Color Detection J J
Resolution (@pi): |200 -
Invert: | Black om White x|
Sean Source |Aum Document Feeder ﬂ
FProfiles |Cmm ﬂ

=

Defaults... Scan | Close

The Scanner Properties dialog box
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4.1 Buttons on the Scanner Properties Dialog Box

&, Scanner Properties g]
Image WCompremnl Calor Dmpout] Paper ] Multi-Feed Detecﬁ.on] Preview ] Opﬁons} Setting ] Impri.nheﬂ 4
[ Front Color S r
[ Rear Color Binarization | Dymamis Theeshold |
[JFront Gray Sensitivity: 20 4| Bl |
P Front B& W
[Rear B&W ] |
[ Front Avto Color Detection
[ |Rear futo Color Detection J J
Eesolution dpi): ‘ZUU ﬂ
Tnvert [Black on White 1
Soan Source: |Auho Document Feeder ﬂ
Profiles |Cmm ﬂ
=
Defaults Scan | Cloze ‘

The buttons on the Scanner Properties dialog box

Buttons | Description

Defaults | Click the Defaults button, the factory default
settings will be shown on each tab.

Scan After all the scan settings are satisfactory, click
the Scan button to start scanning your
document.

Close Click the Close button to leave the Scanner

Properties dialog box.

42
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The following table shows the default settings :

Tab name

Default settings

Image

Image : Front B&W

Binarization : Dynamic Threshold
Resolution : 200 dpi

Invert : Blank on White

Scan Source : Auto Document Feeder

Threshold : None
Brightness : None
Contrast : None

Compression

None

Color Dropout

None

Paper Cropping : Automatic
Deskew : Yes
Orientation : Portrait
OverScan : 0.00
Multifeed Detection : None
Unit : Inch

Options Rotation Degrees : None
Blank Page Removal : None
Edge Fill : White > 0 mm
Image Control Option : None

Setting Enable Energy Saver : Enable, 15

minutes after last scan action
Show Scanning Progress : Yes
Show Warning Message : Yes
Save Settings after Closing : Yes

S400 Manual V.5 Aug 2010
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4.2 The Image Tab

The Image tab allows you to choose the front side and (or) the
rear side of your document, the type of image, and to set
several basic scan settings. Note that except for the resolution,
you can set individual scan settings for the front side and the
rear side. For example, all settings in the Image tab,
Compression tab, Color Dropout tab can be set individually for
the front and the rear side. However, the settings in the Paper
tab, the Option tab, and the Setting tab have to be set the
same for the front and rear side.

& Scanner Froperties E]
Image ]Compremn] Color Dmpout] Paper ] Multi-Feed Detecﬁon] Preview ] Opﬁom] Setting ] Imprimer] i
[ [Front Color B -

[Rear Color Binarization: |Dymmlc Threshold j
[Front Grey Sensitivity 0 4« &l |
[ Front Auio Color Detect J J
ront Auto Color Detection
[Rear Auto Color Detection J J
Resolution (dpi): |200 R
Tnvert: |Black on White j
Scan Sovrce: |Auiu Document Feeder j
Profiles |Cu.s1um j
=
Defaults... Scan Cloze

The Image tab dialog box
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4.2.1 The Image Selection Box

Front Color

[Fromnt At Colar Detection
[Fear Anto Color Detection

The Image Selection box includes the image type and document
side option. If you wish to scan both the front side and the rear
side of your color document, you can check both Front Color and
Rear Color at the same time. You can configure the Front and Back

sides independently. Note the options vary based on type of
scanner.

Example 1 : Scanning a two-sided color document, both sides
in color

[Front At Color Detection
[ Rear Auto Color Detecton

e e

Side/Image
Selection Front Rear
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Example 2 : Scanning a two-sided color document, one
in B&W(Drop Blue Color : Threshold : 10, Background :
79), the other in color

Front Color

[JFront Suto Color Detection
[|Rear Auto Color Detection

Side/Image i

Selection Front Rear

Image Type Description

Color Choose Color if you wish to scan a color
image for your original in color.

Gray Choose Gray image if your original contaii
actual shades of gray. If you are scanning
black and white photo, use this option.

B&W Choose B&W if your original contains only

text, pencil or ink sketch.

B&W

Gray Color
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Front/Rear Auto Color Detection:

Click to automatically detect and scan the front or the rear
page of your color document in color image mode. If your
document is in color, the scanner will automatically scan the
document into a color image. If your document is non-color,
you can choose the output to be either B&W or Gray from the
Non-Color Selection option. This option is typically used when
you have a mixture of color and non-color document.

Note: If you enable Auto Color Detection for either side, it will
be enabled for both sides if you are scanning in duplex.

Sensitivity of Auto Color Detection

If your documents contain primarily B&W text and small
amount of light or pale colors and you do not wish them to be
recognized as color image to save the file size, you can reduce
the sensitivity value by moving the bar to the left to let these
images to be detected as B&W. The value ranges from 1 to 30.
The default is 20.
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4.2.2 Other Image Options

Binarization

This is the process of converting a
grayscale or color image to a bi-tonal or
Black and White image. There are several
different methods of performing this
conversion. Options: Dynamic
Threshold, Fixed Processing, Halftone
1~5, Error Diffusion.

Dynamic Threshold: Selecting
Dynamic Threshold allows the scanner
to dynamically evaluate each document
to determine the optimal threshold value
to produce the highest quality image.
This is used to scan mixed document
containing faint text, shaded background,
or color background with a single setting.
If Dynamic Threshold is selected,
Threshold, Brightness, and Contrast are
not available.

Sensitivity of Dynamic Threshold

Occasionally your scanned image may
contain small dots or speckles. To remove
these spots, increase the sensitivity value
by moving the bar to the right. The value
ranges from 1 to 30. The default is 20.
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Fixed Processing: Used for black-and-
white and other high contrast documents. A
single level is set to determine the black-
and-white transition. The threshold is
programmable over the entire density
range. Fixed Processing sets Contrast to
0. If Fixed Processing is selected,
Contrast is not available.

Halftone: In addition to the black and
white display, Halftone can present a
somehow gray shade of image by using
different size of dots. Halftone image looks
like the picture we have seen in the
newspaper. Options include Halftone 1,
Halftone 2, Halftone 3, Halftone 4,
Halftone 5.

Error Diffusion: Error Diffusion is a type of
Halftone. Error Diffusion gives good image
texture and makes text in images more
readable than Halftone.

Halftone Image
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Threshold

Used to convert a grayscale image to a
bi-tonal image. The value ranges from 0 to
255. A low threshold value produces a lighter
image, and can be used to subdue
backgrounds and subtle, unneeded
information. A high threshold value produces
a darker image, and can be used to help pick
up faint images.

Adjust the threshold setting by dragging the
Threshold sliding bar to the left or right to
achieve the desired threshold setting.

200 dpi, 200 dpi,
Th_reshold:80, Threshold:170,
Brightness: 0 Brightness: 0
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Gray

Document Type: Normal, Photo, Document

Three options of document type are provided when you choose
Gray as the image type for your scanned document. Choice:
Normal, Photo, Document.

. Document: Choose Document if your original contains
pure text or a mixture of text and graphic since it is an
optimal setting for regular business document. When
using Document, only Threshold can be adjusted.

. Photo: Choose Photo if your original is a photo or similar
to reproduce your photo in vivid grayscale image. When
using Photo, Threshold and Contrast are locked.

) Normal: When using Normal, Threshold, Brightness, and
Contrast can be adjusted.

Threshold: The value ranges from 0 to 255. The default is
230. A low threshold value produces a lighter image, and can
be used to subdue backgrounds and subtle, unneeded
information. A high threshold value produces a darker image,
and can be used to help pick up faint images. Adjust the
threshold setting by dragging the Threshold sliding bar to the
left or right to achieve the desired threshold setting.
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Normal Photo Docur.rn'ént
(Threshold: 230)

Normal Photo Document
(Threshold: 230)
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Brightness

Contrast

Adjusts the lightness or darkness of an
image. The higher the value, the brighter
the image. Drag the slider to the right or
left to increase or decrease the brightness.
The range is from -100 to +100.

Adjusts the range between the darkest and
the lightest shades in the image. The
higher the contrast, the bigger the
different grayscale. Drag the slider to the
right or left to increase or decrease the
contrast. The range is from -100 to +100.

Brightness: -50

AAAAAA

Brightness: 0 Brightness: +50
(Normal)

Contrast: -50

Contrast: +50

(Normal)
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Resolution

Resolution is the value that controls how
much information is captured when the scan
is performed. A higher resolution will
capture more information and increase the
file size, trading off performance for quality.
Most business documents are best saved in
200 or 300 DPI (Dots Per Inch) depending on
the size and quality of the text. For
reference, an letter size color image scanned
at 300 dpi at in color consumes about 25 MB
of disk space when uncompressed. A higher
resolution (over 400 dpi) is only
recommended when you need to scan a very
small area.

Choose a resolution value from the drop
down list. The default value is 200 dpi.
Available resolutions are 75, 100, 150,
200,300, 400 and 600. Or you may manually
set the resolution by clicking the button
labeled [...] next to the drop down list and
enter your desired value, pressing the Add
button to include it in the drop down list.

Resolution: 75 dpi Resolution: 150 dpi
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Invert Reverses the brightness and the colors in the
image. The default setting is Black on a White
background. Reverse mode is White on a Black
background. For color images, each pixel will be
changed into its complementary color at the
command of Invert.

“I am not worthy to have you enter my

: that is God, I beg all my brothers - those w
e who work manually, clerics and lay brothers
ards belng humble in all things; not to glorify
r to become interlorly proud because of good w
sarretimeas says or does in them or through tl
ard:  “Do not rejoice--- in the Fact that the de
1 10:20} Let us be firmly convinced of the fact

‘Black on White

“I am not worthy to have you enter m

that is God, I beg all my brathers - those v
E who work manually, clerics and lay brothe

rds being humble in all things; not to glorify
to become Interlerly proud because of good
sometimes says or does in them or throyugh Y
rd: “Do not rejoice--- in the fact that the d4g
10:20) Let us be Airmly convinced of the fa

White on Black
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Scan Choice:
Source . Auto Document Feeder: Used to scan
multiple pages.
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Color The purpose of Color Matching is getting the

Matching accurate color. This option uses the default
parameters (ICC profile) to adjust the colors
of the image.

After Color Adjustment

4.2.3 Scanning color images

The following options are available for scanning color images.

. Brightness

. Contrast
. Resolution
. Invert
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4.2.4 Scanning grayscale images

The following options are available for scanning gray images.

. Brightness

. Contrast
. Resolution
. Invert

4.2.5 Scanning B&W images

The following options are available for scanning B&W images.

. Binarization (Dynamic Threshold)
. Resolution
. Invert
Or
. Binarization (Fix Processing)

. Threshold
. Brightness
. Resolution
. Invert
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4.2.6 Editing Profiles

The Scanner Properties dialog box allows you to change and
save your frequently used scan settings into a profile. You can
edit these profiles by renaming or deleting them.

To add a new profile,

1. Customize your settings. (For example, change your
resolution, image type, cropping method, scan size, or
other scan settings.)

2. Click the Image tab and then choose “Profiles” to prompt
the “Edit Your Profile” dialog box.

nt ket Color Detection
| Ress b Color Detection.

i
Reslubon {dpi): 200
T Frofile RS - Delee
. [k on Wl
Renzme Rest
Scan Souee: [ Auto Document Feeder
=
Exit
Defauks... S | Clse

3. Click “Add"” to enter the name of the profile and then
choose “Save”.

Add A New Profile

Pleaze enter the name of the profile:

[
Save | Cancel |

4. The new profile will be saved and shown in the “Profiles”
dropdown list box.
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To load a profile,

1. From the Image tab dialog box, choose your favorable
profile from the “Profiles” dropdown list box.

Edit Your Profile [:”E‘ E‘

Profile:

Bimplex - Grrayy, 200dp1

2. Your favorable profile will be immediately loaded and
displayed on Scanner Properties dialog box.
To delete a profile,

1. From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.

Edit Yonr Profile

Fuotile - Dekete
Fename Fesst

2. Choose the profile you want to delete from the dropdown
list box.

3. Click “"Delete”. A Confirm message “Are you sure you want
to delete this profile?” is prompted.

4. Choose “Yes” to delete or “"Cancel” to quit.
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To rename a profile,

1. From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.

Edit Your Profile [Z”E‘ E‘

Profile:

2. Choose the profile you want to rename from the dropdown
list box and then click the Rename button.

3. Enter new name for the profile.
Rename a Profile E|

Please enter the new name of the profile:

Original Name: |Betey

Mewr Wame: |

Cancel |

4. Choose “"Save” to save the new profile or “"Cancel” to quit.

Note:

The preset default profiles include Simplex-B&W, 200 dpi,
Simplex-Gray, 200 dpi, Simplex-Color, 200 dpi, Duplex-B&W,
200 dpi, Duplex-Gray, 200 dpi, Duplex-Color, 200 dpi.
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4.3 The Compression Tab

The Compression tab allows you to compress your scanned
image and choose the level of compression. Bi-tonal images
are normally compressed using CCITT standard called Group 4
(G4). Color and grayscale images are often compressed using
JPEG technology. Move the JPEG Quality slider to the right or
left to increase or decrease the level of compression. Note the
greater the compression level, the lower image quality. Default
is 50%.

Note that when scanning from certain applications, not all
compression modes are supported. If the application does not
support the type of compression format, typically you will see
an error or a black image.

JPEG (Joint Photographic Editor Group). This group developed
and lent their name to a file compression standard for color and
grayscale images that is widely used by scanners, and software
applications. On Microsoft Windows-based systems, a file with
the extension .jpg has normally been compressed using this
standard.

For scanning color or gray images, the following compressions
are available:

. None

. JPEG

For scanning B&W images, the following compressions are
available:

. None

. G4
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3—' Scanner Properties

Image Compression | Color Dmpouti Paper ] Multi-Feed Detecti.on] Preview ] Opti.ons] Setling ] Imprimer] I 4 ] L4

[ JFront Colar
[Rear Color .
[JFront Grrayr L

[Rear Gray | TPEG Quality: ] 50%
[JFront B&W
[ Rear BE&:W
[ Font A

| Compression:

[ Resr Auto Color Detection

Defaults Scan ] Cloze

The Compression tab dialog box
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4.4 The Color Dropout Tab
4.4.1 Color Dropout Selection

Color Dropout is a special type of image processing designed to
improve OCR results by removing specific types of background
color content. Typically this is used in conjunction with
specially designed forms that have colored boxes or
checkboxes that people fill in. Using dropout allows you to
remove these specially colored boxes from the image and
provides you with better OCR results. It can also be used to
remove a specific background color if it is causing a lot of noisy
speckling.

From the dropdown menu, you can select any of the standard
RGB color channels to be removed, or Custom to allow you to
specify your desired color to be removed by entering its RGB
(Red, Green, and Blue) value respectively.

Tolerance: Specify the allowable color range to be removed for
the color you selected. Specified range: 1 ~ 100

The large the numeric value, the wider the color dropout range
is.

Note that this function is only for outputting black & white or
gray images.
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¥ Scanner Froperlies

Tinage ] Compression  Color Dropout ]Paper ] Multi-Feed Detech.on] Preview ] Optinns} Setting ] Imprmter] 4

[ Front Color
[CIRear Color Color Dopout:
[ Front Grray
[ Resar Groayr
I Tolerance ﬁ

[ |Resr B&W
[ 1Front Auto Color Detection _]
[ Rear Auto Color Detection

Red

Grreen:

Blue:

Defauls... Scan | Close

The Color Dropout dialog box
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4.4.2 Other Color Dropout Options

Advanced Processing provides two options that can adjust
your scanned image in the best optimal result.

Filter This value is used to determine the color

Threshold which will be dropped out. A lower value will
drop more of the selected color out, while a
higher value will leave more of the selected
color in.

Background The pixel which is higher than the

Level background value will be adjusted to the
lightest point. Adjust the value for both the
Filter Threshold and Background Level to
produce the best optimal result.

Example, slightly adjusting the background value makes
your text more clear.

AMB120%:

Original
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AME120FE S LIRS IR

Remove Blue, Threshold: 20, Background:
255

AME120%; [ BITEER S IS
) [T
wEinn

EEGI 1)

Remove Blue, Threshold: 20,
Background Level: 210
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4.5 The Paper

Tab

The Paper tab allows you to define values relating to image
output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-Feed

Detection).

& Scanner Properties

Cropping:

Bran Area:

Crverdcan:

Feeding
Pre-Feed:

Waiting Job

Unit:

Image } Cnmpmsmnn] Color Dropont Paper ]Mulh—Feed Detechﬂn] Preview ] Ophnns] Setting } Impnnter] 4

3

=
|None ﬂ
% Portrait 5
= E
F-Oifset: 0.00 - EE 18
With 536 = .
Length: 1086 = v Center
—
[ =
Top: 0.00 =
Bottom: 0.00 -
| Disable =]
ﬂ v | 9 3econds
|Inches j

Diefalts..

Scan

Cloze
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The Paper tab dialog box
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4.5.1 Cropping

Cropping allows you to capture a portion of the document
being scanned. Choice: Automatic, Fixed to

Transport, EOP

(End of Page) Detection.

Options

Description

Automatic

Automatic adjusts the cropping window
according to different document sizes. Use
this option for batches of mixed-sized
documents.

Fixed to
Transport

This feature allows you to define the area
or zone to be imaged. Use for batches of
same-sized documents. If you select this
option, you can use the arrow keys to
define the x and y offset values, width and
length to redefine your scanned area. The
Display window will show image placement
as you change the values.

EOP (End of
Page)
Detection

This feature allows you to define the area
or zone to be imaged. Use for batches of
same-width but different length
documents. If you select this option, you
can use the arrow keys to define the x and
y offset values, width and length to
redefine your scanned area. The Display
window will show image placement as you
change the values.
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The following options are only available when Fixed to
Transport is selected.

. X-Offset — the distance from the left end of the
scanner to the left edge of the scanning area.

. Y-Offset — the position from the top end of the
document to the top end of the scanning area.

. Width — the width of the scanning area.
. Length — the length of the scanning area.

. Center: automatically calculates the x-offset for center-
fed feeding based upon document size selected.

o

. — relocate the scan area by click the arrow key on
the cross sign while retain the scan size. View the result
from the Display window.
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4.5.2 Other Paper Selection

Deskew

Use this option to automatically deskew a document.

P i & | konxanmte 0]
! == £ LT Note: If the document
& & _ feeds at too much of an
I angle, some of the image
; may be cut off.
Scan Area

Choose your desired paper size with the drop-down list box. Or
you may select a custom paper size by clicking the Scan Area
box and then click Add to include in the choice.

Choice: None, US Letter- 8.5"x 11”7, US Legal - 8.5” x 14",
ISO A4 - 21 x 29.7 cm, ISO A5 - 14.8 x 21 cm, ISO A6 - 10.5
x 14.8cm, ISO A7 - 7.4 x 10/5 cm, ISOB5 - 17.6 x 25 cm,
ISOB6 -12.5x17.6 cm, ISO B7 - 8.8 x 12.5 cm, JIS B5 -
18.2 x25.7cm, JISB6 - 12.8 x 18.2cm, JISB7 - 9.1 x 12.8
cm, Scanner Maximum, Long Page.

Long Page:

When you need to scan documents whose length exceeds
scanner maximum, please choose Long Page. Note if Long
Page is selected, the Multi-Feed Detection will not be available.
Options: Unknown Length, Enter Length (Note: This option
varies due to type of scanner.)
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Choose “Unknown Length” if you have a batch of long page
document with unknown length. Choose “Enter Length” to
enter the length and width of your documents or your desired
scan size on documents. This is useful when you have a batch
of documents with the same scan size or a batch of same-sized
documents.

OverScan

Overscan allows you to add a specific margin at top and bottom
or right and left (Options vary based on the type of scanner) of
the edge of the image. This is used to reduce possible corner
clipping on the skewed images and often applied to a batch of
skewed document to be scanned in the auto document feeder.
Select a value between 0 and +5 mm. Note the overscan
result will not be shown in the Display window and that the
availability of the function varies based on type of scanner.

Pre-Feed

Choice: Enable, Disable. If enable is selected, you can set the
amount of time the scanner starts pre-feeding your paper after
your documents has been loaded into the feeder. The default is
disable.

Transport Timeout

Set the amount of time the scanner will wait and then start
auto scan after the first scan job is completed. If you have
many separate documents need to be scanned at the same
scan settings, this feature is especially useful. The default is 0.
The value ranges from 0 to 30 seconds.
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Note:

1 Within the specified timeout period, if you load your
document to the feeder, the scanner starts scanning
automatically.

4.5.3 Multimode cropping

This feature provides flexibility if you are performing a scan
that outputs in a more than one mode (B&W, Gray, or Color);
you can assign different crop areas on your documents for each
color mode. For example, there are applications which require
you to store the entire form in B&W and a part of the document
in color to save storage space. This is useful for documents
where a photograph, or signature appears in a consistent area
on the document such as resumes, and so on.

The following directions describes how to scan the entire
document in B&W and keep a small portion of the document
(picture) in color.

1. On the Paper tab, choose “Relative to Document” or “Fixed
to Transport” from the Cropping option.

2. Choose your scan size from the Scan Area option. The
selected scan size will be displayed in a red rectangular
box. This is also the scan size of your entire document. (If
you have not chosen a scan area and leave the selection
as None, then the default area will be the scanner’s
maximum.)
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& Scanner Properties

Image | Compression | ColorDropout Paper | Muli-Feed Detectian | Proview | Options | Sefiing | lmpranter | 15 4| »

Cropping [P to Tronspart

Sean A

=

i
M [ 2
Y-Offt. [ omy o f
st o]
Length: 984_+_1 ¥ Cener
Oveiean: I =
=
Top. 000+
Borem: [oms]
Feeding.
e o Dee ] =
Transport Timsout KiN| | 0Seconde
Uit [Taches =]
Defals

Scan Area

3. Click the Preview tab to display the Preview window. A
black rectangular box appears to indicate the max. scan
size your have just selected.

The Image
Selection
Box

[IRear Auto Color Detection

Sean Area:

150 B5 - 176 %250 mm. -
(v Portreit [ 3
g L7 —
H-Offset [052 =4
¥-Offset. 000 j
Widh 693 -
=
Lengh g6 -
Uit Tnches =l

™ Selecid aree applies o ol modes

Defaults:

Freview

The selected
image

A black
rectangular
box

4. Click the Preview button to view the entire image in low
resolution to correctly crop your relative scan area.
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Image | Compreesion | Color Dropout | Psper | Mult-Feed Detecton  Preview | Options | Satting | lmpriver | 1:.9] »

Front Auto Color Detection
Rear Aub Color Detection

-  The Preview

Image

150 BS - 176 % 250 mm =]

fae :

KOffat T

V-Ofet [6% =

Wit o

Lengh: T .
] =~  The Preview

I Selected ares apples 1o oll modes

Button

Detaits | ey | sen | oo |

Select the image type from the Image Selection box. The
selected image will appear in highlighted color. (For
example, Front Color)

Place your cursor on the Preview window and click your
left mouse button. A cross sign will appear as illustrated.
Create your relative scan size diagonally by dragging the
left mouse button to your preferable size. The selected
area will appear in a red box as illustrated.
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-~ |Rear Colox
A Cross

Front B&F

i Rear BAW
Sign 7 —

Scan Area:

 Portsit

150 B5 - 176 %250 mm. -

I Selected area spplies o ol modes

Rear Auto Color Deteetion.

=

a—
0.00 j
o
054 j

[fneres ]

The
Relative
Area

- Defaults.

| e

7. Check the B&W image from the Image Selection box to
scan the entire document.

8. Click the Scan button to start scanning the document in
two image types and sizes. (See the result in below.)

mploys ol

s Lanls o it g ey

waier snl

Sevting 5

The entire document in B&W
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4.6 The Multi-Feed Detection Tab

Multi-Feed Detection

Multi-Feed Detection allows you to detect overlapped document
that go through the auto document feeder. Multi-Feed usually
occurs due to stapled documents, adhesives on documents, or
electro-statically charged document. Note : The availability of

the function varies based on type of scanner.

Tmage ] Cnmpmﬁinn] Color Dmpnull Paper  Multi-Feed Detection IPIeview ] Ophnns} Setting ] Impn'nlnr] LAl
0.00
Iv Ultrasonic Detection
Intelligent Mode i
(Skip Multi-fesd): |Disable =
Rest
Detection Area: |Enﬂh1& ﬂ
Top: o0 =
Eottom. 1400+
[~ Stop Scanning after Multi-Feed
Multi-Feed Alarm; CAWINDOWE Med ialding way :‘ Browss..
Wit Inches ﬂ
Defaults... Scah Close
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Additional Length Detection

Additional Length Detection allows you to define the length of
document being multi-fed. This value indicates the additional
length exceeding your scan area. The Display window will
show the size of the document as you change the value. A
value of 0 indicates no additional length detection. The
Additional Length Detection is best used when scanning same-
size documents in the auto document feeder.

There are two options available if Multi-Feed is detected.

e Stop Scanning after Multi-Feed

If this is selected, the scanner will stop the feeder and
display the following Warning dialog box if multi-feed is
detected.

' E ultifeed iz detected, pleaze remove the rest paper from ADF.
L

Action:

1. Follow the instruction on the Warning dialog box to
remove the rest pages on the feeder.

2. Click OK to close the Warning dialog box.
3. Scan the rest pages.
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Clear the Multi-Fed Paper:
Choice: Manual, Auto

If Auto is selected, once multi-feed is detected and scanning
operation is stopped, the scanner will automatically clear the
transport of the multi-fed paper. If manual is selected, once
multi-feed is detected and scanning operation is stopped, you
need to manually clear the transport of the multi-fed paper.
Note: The availability of this option varies based on type of
scanner.

e Multi-Feed Alarm

If a wave file is added, the scanner will make a sound
alarm if multi-feed is detected yet no Warning dialog box
will be displayed.

If “"Stop Scanning after Multi-Feed” is selected, the scanner
will stop the feeder.

If "Stop Scanning after Multi-Feed” has not been selected,
the scanner will continue to scan till the end of your
document.

Action:

1. If “Stop Scanning after Multi-Feed” is selected, follow
the action described in the preceding section “Stop
Scanning after Multi-Feed” on the previous page to
complete your job.

2. If “Stop Scanning after Multi-Feed” has not been
selected, rescan the pages where multi-feed is
detected.
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How to add the sound alarm :

1. Click the Browse button on the right side of the speaker
icon. The Open dialog box appears.

2. Choose your wave file.

3. Click the Open button. The wave file is added.

Units

Defines the primary measurement system. Inches,
Millimeters, and Pixels are available.
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4.7 The Preview Tab

The Preview tab allows you to preview (a low-resolution scan)
your image before the actual scan. This preview image lets
you manually set your scan area. You can choose your scan
area from the “Scan Area” drop down list box or placing your
cursor on the Display window and dragging it diagonally on the
Display window. Then, a red rectangle box will appear to
indicate the selected area.

Note: If you choose “Automatic Cropping” on the “Paper Tab”,
then selecting a scan area on the Preview tab is disabled.

Image ] Cumpremn} Color Dmpum] Faper } Multi-Feed Detection  Previsw IOpIiDns] Retling } Impnmsr} LAlr

[ JFront Autn Color Detection The DISplay
[JEear Lutn Color Detection W | n d OW
Sran Area

[180 B5 - 176 % 250 mm Bl

& Portrait &

E-Offset [E5 =

. =

¥-Offset: 0.00 j

Width: .93 j

Length 9.64 =

Unit: Inches ot

[~ Selected area applies to all modes

Defaults. Preview ‘ Secan Clase

The Preview Tab

4.8 The Options Tab
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The Options tab allows you to set following additional image
processing settings.

L}, Scanner Properties &‘
Timage I Compression] ColorDmpout] Paper ] Multi-Feed Dehech.on] Praview Ophons ISet‘Hng ] Imprinher} L
Flip $ide Eotation
P =i 1
|4 ¢ Book 4| ¢ Fanfold
Eotation
Rotation Degrees : Hone -
Elank Page Removal
[ Blank Page Removal Threshold: )I
T A A
Edge Fill Despeckle
v White ,_ Noiss Number: 42 il Pixels
0 Millimeters
" Black Noise Radius: 10 = Piels
Image Cantrol Options
[~ Mimar
Beckgromnd Betting
{+ White Background " Black Background

Defaults... Scan Cloze

The Option tab dialog box
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Flip Side Select “fanfold” to rotate the image
Rotation of the reverse side to 180 degrees.

This is applied to double-sided
document which are viewed in
portrait are sometime fed into the
scanner in landscape or vice versa.

Choice: Book, Fanfold.

If "Book” is selected, the image of
the reverse side will not be rotated.

The following illustration shows the documents which should
be viewed in portrait are fed into the scanner in landscape

A
et
- = a8 > [
= s <
i K ’ §82 S Il
o & E: =
% : L s5f° B
gg 4{ o B &5
Zo £ Ha E ]
538 | B
i U 3z .
H / /] @3 %
/] g2
/ a3
/ "
O 3%
: B
B
wﬁ
,E
[ ]
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Rotate Image

S400 Manual V.5 Aug 2010

Choose the rotation angle from the drop
down list if you wish to rotate your
scanned image.

Choice: None, 90°CW(clockwise),
90°CCW(counter clockwise), 180°,
Auto based on contents. Auto rotate
every even page.

123 —

(N
(IS

Original
Rotate 90°CW

¢ €zl

Lo

Rotate 90°ccw Rotate 180°

Auto based on contents: When Auto
based on contents is selected, images
can be rotated to their proper
orientations based on their contents.
Auto rotate every even page:
Automatically rotate 180° on every
even page. This is especially useful

when you scan the inside pages from a
book.
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Blank Page Check if you wish to remove the blank page
Removal and move the slider to the left or right to your
desired threshold.

Edge Check White or Black if you wish to add white or
Fill black edge on the border of your scanned image.
Enter the value from 0 to 5 mm. Default value is 0.

Original Edge Fill: 5mm (Black)
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Image Check the Mirror box if you wish to reverse the right
Control and left side of your image.
Option

L
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Despeckle

Occasionally small dots or specks appear in the background of
a scanned image. Remove unwanted speckles provides a
cleaner image for OCR (Optical Character Recognition)
processing, and also helps to reduce compressed file size.

Define the speckles (also known as image noise) you wish to
remove by specifying its number (size) and radius (range). The
measuring unit is pixel. The higher the number, the more
speckles will be removed.

(;%plague on thee! Hast thou

never an eye in thy head? Canst

not hear? .

—The First Part of King Henry the Fourth:
2.1.26-27

A carrier to Gadshill, the host of a tavern.

Before Despeckle
(noise number:0, noise radius:1)

(%plague on thee! Hast thou
never an eye in thy head? Canst
not hear!?
—The First Part of King Henry the Fourth:
2.1.26-27

A carrier to Gadshill, the host of a tavern.

After Despeckle
(noise number:22, noise radius:10)

Note:
o The function is currently available for Black and White
image only.

Background  This option allows you to set your scan
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Setting background.
Choice: White Background, Black
Background.

White Background

Black Background
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4.9 The Setting Tab

The Setting tab allows you to set the following settings:

= Scanner Properties

Image Comprea&on] Color Dmpout] Paper ] Multi-Feed Detecﬁon] Preview ] Cptions  Setting lImprinher] 4l
Cache

Mode: | Memory Size |

WA [ 5 MB  (Reg:l~l46ME)

Energy Saving Control

’} [ Enable Energy Saver ﬂ J ﬂ s

[v Bave Settings after Closing

Defaults... Scan Cloze

The Setting tab dialog box

Energy Saving Check the Enable Energy Saver box

Control and move the slider to the right to set
the amount of time to start the energy
saver after your last action. The range
is from 1 to 240 minutes. The default
is 15 minutes.
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Cache Mode: None, Page Number, Memory
Size.

This option allows you to assign a specified
memory size from the available RAM to
process the image data. By specifying a
smaller memory size, you can free more
memory for other applications you are
running. By specifying a larger memory
size, you can have more memory to
process the image data especially when you
have a large amount of documents needed
to be scanned.

You can also specify your memory size by
the page number. For your information, an
A4 color document scanning at 300 dpi
consumes approximates 24MB.

Image Count

When the selected cache mode is “none”,
the image count option allows you to assign
number of pages you need to scan. For
example, if you wish to scan the first two
pages, simply move the page slider to 2,
and the scan action will be stopped when
the scanning of the first two pages have
been completed.

Barcode Check this option to enable detecting and
Detection recognhizing barcode in your document.
After the detecting process, an
avbarcode.ini file will be generated and
stored in your system drive, for example,
Windows\avbarcode.ini.

Note: The availability of this feature varies
based on type of scanner.
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Show Scanning
Progress

Check and the scanning progress bar
will be shown during scanning.

Show Warning
Message

Check to show the warning messages
such as “"ADF pad count exceeds
50,000 scans (the number varies based
on type of scanner). Please replace the
ADF pad and reset the pad count.”

Save Settings
after Closing

Check to save your scanner properties
settings after leaving the dialog box.
Next time when you open the Scanner
Properties dialog box, the previously
saved settings will be shown.
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4.10 The Information Tab

The Information tab displays the following system and scanner
information.

£ Scanner Pro perties g|

Image | Compression | Color Dropout | Paper | MultiFeed Detection | Preview | Options | Setting || Imprinter | Information

CPU: Intel[R) Care{TH)2 Duo CPU - T9300 @& 250GHz ~
Résk: 1023 MB

0s: Service Pack 2 [Build 3730)

05 Language: Englizh [United States)

Disk Drive: Fiwed drive C:\0T otal: 40950MBIF ree: 327 25MB

Free Dizk Space: 32725 MB

Application Name: Capture Tool 1.6(1.9)

Tl Driver Yersion: 101001210

1/0 Drriver Version: 5, 0,2009, 1027

Fort Type: USE

1D/ Address: use

Optical Resolution EO0 dpi

Scanner Model: FEOO

Serial Mumber:

Fwf Wersion: 0.34

Background: ‘wihite Background w

Defaults...

The Information tab dialog box

The “"Report” button :

If you encounter any error message while using the scanner,
click the Report button. A report.txt file (C:\S400) will be
generated. Please send this file to the nearest service center
for trouble shooting.
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The “"Reset Pad Count” button |

After scanning approximately 20,000 pages (the number varies
based on type of scanner, type of paper and size of batches)
through the Auto Document Feeder (ADF), the ADF pad may be
worn out and you may experience problems with document
feeding. In this case, it is highly recommended to replace the
ADF pad with a new one. (Please refer to the manual for proper
replacement procedure.) For ordering the ADF pad, please
consult your nearest dealer. After replacing the ADF pad, click
the "Reset Pad Count” button to reset the pad count.

The “"Reset Roller Count” button |

After scanning approximately 100,000 pages (the number
varies based on type of documents scanned) through the ADF,
the ADF roller may be worn out and you may experience
problems with document feeding. In this case, it is highly
recommended to replace the ADF roller with a new one. (Note
the replacement of the ADF roller has to be performed only by
authorized service center. Therefore, please return your
scanner for roller replacement.) After replacing the ADF roller,
click the "Reset Roller Count” button to reset the roller count.

Note :

The lifetime and the replacing procedure vary based on type of
scanner. Please consult your nearest dealer for more details.
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5. Using the Buttons

The following picture shows the 3 buttons and 1 function
screen on the scanner.

The Scan button

Function-display screen
Function selector
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5.1 The BulletScan Manager

The buttons on the scanner are controlled by the BulletScan
Manager. It is installed by default from the CD when you use
the Easy Installation mode, and is selected by default when
choosing the Advanced Installation mode.

Please consult the BulletScan Manager Manual for how to use
and configure the buttons.

The BulletScan Manager provides you with an easy way to scan
your document and then link the scanned image to your
designated software application. All this can be done by a
simple touch of the button on the scanner. It is recommended
to examine the button configurations first for the best results.

5.2 Scanning From One Touch of the Buttons

1. Adjust the paper guide for the width of paper and load the
document facing down with their tops into the automatic
document feeder.

2. Check the number on the knob of the scanner to ensure if

you are selecting the proper scan settings and destination

application.

Press the Scan button on scanner.

After the scanning is finished, the destination application

will be launched and the scanned image appears in the

application.

AW

5-2



User’s Manual

6.

6.1

Maintenance

Cleaning the ADF

From time to time the ADF pad and feeding rollers may
become contaminated with ink, toner particles or paper dust.
In this case the scanner may not feed documents smoothly.
If this occurs please follow the cleaning procedures to return
your machine to its original state.

The Cleaning Procedures

1.
2.

Soak a cotton swab with some isopropyl alcohol. (95%).

Press the Paper Jam Clearing button. Open the front door
to the left. Wipe the upper feeding roller by moving the
swab from side to side. Rotate the roller forward with
your finger and repeat the cleaning steps above until the
entire roller is cleaned.

Wipe the pad in one direction from top to bottom or the
other way around. Be careful not to damage the pick
springs.

Close the scanner front door. Your scanner is now ready
for use.
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Paper Jam
Release
Button

ADF Pad

Feeding
Roller
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6.2 Cleaning the Glass

1. Press the Paper Jam Clearing button. Open the front door
to the left.

2. Wet a cotton swab with some isopropyl alcohol. (95%)

3. Wipe the glass and the white area as illustrated in below
by moving the swab from side to side to rid the dust or
dirt.

White Area

Glass
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6.3 Replacing the ADF Snap-in Pad

After scanning approximately 20,000 pages through the ADF,
the pad may be worn out and you may experience problems
with document feeding. In this case, it is highly recommended
to replace the pad module with a new one. For ordering the
pad module, please consult your nearest dealer and follow the
procedure below to replace it.

Disassembling Procedure

1. Press the Paper jam clearing button on the upper-left
corner.

2. Gently open the ADF Front cover to the left.

3. Press both arms of the ADF snap-in pad module inwardly
with your fingers to pull out the ADF snap-in pad module.

Assembling Procedure

1. Take out the ADF pad module from the box.

2. Press both arms of the ADF snap-in pad module inwardly
with your two fingers.

3. Place it into the holes until it snaps into place.
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6.4 Replacing the ADF Roller

After scanning approximately 100,000 pages through the ADF,
the roller may be worn out and you may experience problems

with document feeding. In this case, it is highly recommended
to replace the roller with a new one.

Please follow the procedure below to replace the ADF roller.
For ordering the ADF roller, please consult your nearest dealer.
After replacing the ADF roller, be sure to click the “"Reset
Roller Count” button in the Scanner Properties dialog box to
reset the roller count.

The Disassembling Procedure

1. Move the tab of the roller face up.
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2. Hold and press the roller in the arrow direction as
indicated to remove the roller.

Note:
To install a new ADF roller, please follow the reverse order of
the disassembling procedure.
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7. Troubleshooting

7.1 Clearing a Paper Jam

In the event of a paper jam, follow the procedures below to
remove the paper:

1. Press the ADF Release Button on the left side. Gently
open the Scanner Front Door to the left.

2. Carefully pull the paper out of the ADF unit.

3. Close the scanner front door. Your Scanner is now ready
to use.

Paper Jam
Clearing Button



7.2 Questions and Answers

Question: Scanner reports being jammed, but

everything feeds through fine

Answer: 1) Gently push the paper input tray back until you
feel it click back into place

Question: Paper becomes jammed during scanning.
Answer: 1) Open the scanner front door.

2) Pull out the jammed paper carefully.

3) Close the scanner front door.

Question: More than one sheet of paper is fed into the
scanner.
Answer: 1) Open the scanner front door.
2) Remove the multi-fed sheets of paper.
3) Close the scanner front door.
4)Flatten the corners and edges. Loosen the
paper before putting it into the paper guide
again.
5) Check the feeding roller condition. If
necessary, follow the cleaning directions in
section 5.1 and perform the cleaning.

Question: Paper becomes skewed in the scanner.
Answer: 1) Use the slide guide to keep the paper path
straight.
2) Check the condition of the feeding roller. If
necessary, follow the cleaning directions in
Section 5.1 and perform the cleaning.
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Question: Why is it my scanned image always comes
out too dark?

Answer: 1) Modify the Gamma setting to 1.8 for your
monitor and, when printing, set Gamma to 2.2
for your printer.

2) Use the Brightness setting of the TWAIN user
interface to get a brighter image.

Question: Sometimes it seems the scanner does not
detect paper?

The scanner paper sensor is located at the center
of the paper guide. Please place the document
you need to scan on the paper guide and use the
slide guides to keep the paper path straight.

Answer:
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7.3 Technical Service

Before contacting iVina, please prepare the following
information:

m  Scanner serial & revision number (located on the bottom of
the scanner);

= Hardware configuration (e.g., your host CPU type, RAM size,
free disk space, display card, interface card);
The name and version of your scanning software application;
The version of your scanner driver.

For the latest information, visit us online at:

www.bulletscan.com
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8. Specifications

All specifications are subject to change without notice.

Model Number : BulletScan S400
Scanner Type: Sheet-fed Duplex Scanner (FF-0608S)
Optical Resolution: 600 dpi*1200 dpi
Scanning Modes: Black & White
Gray scale
Color
ADF Capacity: Up to 50 pages
Document Size: Letter, legal, A4, B5, A5, business card

Max. Document Size: 8.5"x14” (ADF)
Min. Document Size: 3.5” x 2” (ADF)

Paper Weight: 16 Ibs. to 24 |bs.
Interface: Hi-speed USB 2.0
Power Source: 24V, 2.0A (FF-0608S)

Power Consumption: <30W (operation)

< 6W (standby)
Dimensions: (WxHxD) 156 mm x 308 mm x 145 mm

Weight: 2.3 kgs
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Index

Automatic, Fix to
A Transport, EOP

. Detection, 4-30
Additional Length

Detection, 4-39 D
Auto Color Detection

sensitivity, 4-7
Ve default settings, 4-3

B Deskew, 4-32
Despeckle, 4-48
Noise Number, Noise

B&W, 4-6 Radius, 4-48

Background Level, 4-27 Document Type

Background Setting, 4-49 Normal, Photo,

B?rco_de, _4-51 Document, 4-12

Binarization Dynamic Threshold
Dynamic Threshold, Fixed sensitivity, 4-8

Processing, 4-8

Blank Page Removal, 4-46 E

Brightness, 4-14

BulletScan Manager Edge Fill, 4-46

Configuration, See

BulletScan Manager Energy Saving, 4-50

Manual
F
C Filter Threshold, 4-27
Cache Flip Side Rotation, 4-45
None, Page Number,
Memory Size, 4-51 G
Color, 4-6
Color Dropout G4, 4-23
Remove Red, Remove Gray, 4-6, 4-12
Green, Remove Blue,
Custom, 4-25 I
Color Match, 4-18
Contrast, 4-14 Invert, 4-16
Cropping
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J

JPEG, 4-23

M

Mirror, 4-47
Multi-Feed Detection, 4-38

O

OverScan, 4-33

R

Reset Pad Count, 4-54
Reset Roller Count, 4-54
Resolution, 4-15

Rotate Image, 4-45

S

Scan Area, 4-32

T

Transport Timeout, 4-33
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